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 – Quick Start Guide 1 

This Guide provides information for using Mindjet Catalyst through your web browser. 

For information on using Mindjet Catalyst with MindManager Version 9 for Windows, 

please consult the Mindjet MindManager for Windows Help and the Mindjet 

MindManager for Windows User Guide. 

http://onlinehelp.mindjet.com/help/MindManager/9/ENU/documents/Mindjet_MindManager_User_Guide.pdf
http://onlinehelp.mindjet.com/help/MindManager/9/ENU/documents/Mindjet_MindManager_User_Guide.pdf
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Mindjet Catalyst is a complete online visual collaboration service that enables you to 

share maps and other documents in real time, and collaborate with other users. You 

can create or upload maps and files, and store your documents on the Mindjet 

Catalyst server, allowing you to access them using your browser, anytime.  

When you create your Mindjet Catalyst account, you become the account Owner. As 

the Owner, you can give colleagues and friends access to your account by inviting 

them to join it. If you are invited to join an account, you become an account User. 

You can be an Owner and User of multiple Mindjet Catalyst accounts. Your account 
automatically includes access to Mindjet Catalyst’s browser-based application for 

creating and sharing maps and other documents.  

Using Mindjet Catalyst, account Owners and Users can create workspaces – discrete 

virtual areas within the account - and give access to the wokspace to a select set of 
account Users. These are called the Workspace Members. You can assign each 

workspace member with an Access Level specific to that workspace. You can create 

multiple workspaces with different sets of members, or you can create workspaces 

for personal use, with no other members. 

Creating new documents with Mindjet Catalyst is quick and easy. Workspace 

members can choose to add content to workspaces by creating new documents on 

the fly, or by uploading existing documents, including MindManager maps, Microsoft 

Office documents, and other files. Members can collaborate with each other by co-

editing workspace maps and editing workspace files.  
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You can get access to the Mindjet Catalyst service in two ways: 

 You can create your own Mindjet Catalyst account. You become the account 

Owner. You can then invite other Users to join your account. 

 You can accept an invitation to join someone else’s Mindjet Catalyst account. 
You become an account User.  

You can be an Owner and User of multiple Mindjet Catalyst accounts.  

Create and sign in to your Mindjet Catalyst account on the Catalyst home page at 
Catalyst.Mindjet.com 

Once you sign in, get quick access to the account management pages by clicking 

 My Account in the Mindjet Catalyst sidebar menu. 
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Create a Mindjet Catalyst account 

When you create your first Mindjet Catalyst account you also automatically create a 

blanket Mindjet ID that contains information about you and about your registered 

Mindjet products and services. This account allows you to easily sign in to see all 
your Mindjet Catalyst accounts, and other Mindjet registered products and services. 

You can create or join multiple Mindjet Catalyst accounts under your Mindjet ID. You 

are the account Owner of each Mindjet Catalyst account that you create. 

Create an account 

In your browser, navigate to the Mindjet Catalyst page at Catalyst.Mindjet.com. 

Click Sign Up for Free Trial or Buy Now. 

You will be guided through three steps: 

1st. Create a Mindjet ID and Catalyst Account. 

2nd. Activate the Mindjet Catalyst Account – you will receive an email message 

from Mindjet with a link to activate your account. Click the link in the email, 

and your Mindjet Catalyst account is ready for use. 

3rd. Invite users to join your account. This is optional – you can invite users to 

join at any time. 

Sign in to your account 

To begin using Mindjet Catalyst, you must sign in. 

1. In your browser, at Catalyst.Mindjet.com, enter your Mindjet ID and password, 

and then click Sign in. 

(You can bookmark this page for quick access.) 

2. If you have more than one Mindjet Catalyst account, in the top title bar 
Accounts menu, select the account you want to use. 
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Invite Users to join your Mindjet Catalyst account 

When you create a Mindjet Catalyst account, you are its Owner, and you can add 

Users to your account by inviting them to join it.  

Users you invite will receive an email invitation and instructions for accepting the 

invitation. You can invite new Users one at a time, or invite multiple Users in bulk 

from information in a file. 

You must be the Owner of an account to invite Users to join it. 

Invite Users individually 

1. In the sidebar menu, click Invite users. 

(If you have just confirmed your account, skip this step. You are taken to the invite 

users page automatically.)   

2. On the Invite Users page enter the information for the User you want to 

invite. 

3. Choose whether you want to allow this User to create workspaces within the 

account.  

Note: Account Users who do not have workspace creation rights cannot create 

their own workspaces, but they can be members of other workspaces and 

work collaboratively in them.  

4. Then, click Send Invitation. 

You’ll see when Users have accepted your invitation on the Manage Account page. 

Users whom you have invited are shown as “Pending”. Those who have accepted are 

shown as “Active”. 
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Invite multiple Users 

You can invite a group of new Users using the Invite Multiple Users tab on the Invite 

Users page. This allows you to import Users’ information in a .CSV (comma 
separated value) file using the following format: 

First name, Last name, email address 

For example: 

 

From the Invite Users page: 

1. Click the Invite Multiple Users tab. 

2. Browse to the .csv file you have created with the list of users you want to 

invite, and select it. 

3. The user information is imported into the form. If errors are found, they will 

appear in red, and you can correct them by editing the information in the 

form.  

4. To assign workspace creation rights to one or more users, select their names 

in the form,  click the Rights pull-down, and then select the rights you want to 

assign. 

Note: Account Users who do not have workspace creation rights cannot 

create their own workspaces, but they can be members of other workspaces 

and work collaboratively in them. All Users in the file will be added with the 

same workspace creation rights. You can change this setting for individual 

Users later, if needed.  

5. To eliminate a user from the group, select the name in the form, and then 
click Remove. 

6. Customize the email message, and then click Send Invitations. 

You’ll see when Users have accepted your invitation on the Manage Account page. 

Users whom you have invited are shown as “Pending”. Those who have accepted are 
shown as “Active”. 

You can assign rights for creating workspaces from this page at any time. 
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Accept an invitation to an account 

When you are invited to join a Mindjet Catalyst account you receive an email 

message from the account’s Owner with a link to accept the invitation.  

If you accept the invitation you become an account User. 

1. Click the link in the invitation email. 

2. Enter the information to create your Mindjet ID. 
Note: if you already have a Mindjet ID, you can Sign In. 

3. Click Create ID and Join Account. 

Sign in to your account 

To begin using Mindjet Catalyst, you must sign in. 

1. In your browser, navigate to Catalyst.Mindjet.com.  

(You can bookmark this page for quick access.) 

2. Enter your Mindjet ID (email) and password, and then click Sign In. 
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Manage your accounts 

As an account Owner or User you can manage your accounts using functions at the 

Mindjet Catalyst Account Management pages. 

1. If you have more than one account, select it from the Accounts list on the 

title bar. 

2. In the Mindjet Catalyst sidebar menu, click My Account. 

3. Choose the account management function you want to use. 

Edit your Mindjet ID profile and information 

 Change your email address, display name, and other profile information. 

Manage Account (account Owners only) 

 Manage Users’ account access - Change Users’ workspace creation rights, or 

remove Users 

 Change the account name and description  

Buy / Upgrade Mindjet Catalyst (account Owners only) 

 Purchase your trial account 

 Upgrade your account to add more Users, or storage 

Help and resources for Mindjet Catalyst Accounts 

Mindjet offers a variety of resources to help you get the most out of using Mindjet 

Catalyst. 

In the sidebar menu, click  Support. 



  

 – Quick Start Guide 9 

When you subscribe to the Mindjet Catalyst service you automatically get access to 

the Mindjet Catalyst browser-based application for creating and sharing workspaces 

and maps.  

Mindjet Catalyst online mapping is similar to its more powerful desktop cousin, 
MindManager for Windows. If you own MindManager for Windows you can use these 

online features to access your Mindjet Catalyst workspaces and documents from any 

computer. 

This Guide provides information for using Mindjet Catalyst through your web browser. 
For information on using Mindjet Catalyst with MindManager Version 9 for Windows, 

please consult the Mindjet MindManager for Windows Help and the Mindjet 

MindManager for Windows User Guide. 

Sign in 

When you create a Mindjet Catalyst account or when you are invited as an account 
User, you’ll create a Mindjet ID and Password to connect to your accounts. You sign 

in with this information when you want to use Catalyst. 

1. Using your browser, navigate to Catalyst.Mindjet.com, and then log in with 

your Mindjet ID (email) and Password. 

2. Click Sign in. 

3. If you have more than one account, choose the account you want to use in 
the Account menu on the Catalyst title bar. 

http://onlinehelp.mindjet.com/help/MindManager/9/ENU/documents/Mindjet_MindManager_User_Guide.pdf
http://onlinehelp.mindjet.com/help/MindManager/9/ENU/documents/Mindjet_MindManager_User_Guide.pdf
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The Mindjet Catalyst menu 

Once you have signed in you can begin mapping by using the commands in the 

Mindjet Catalyst sidebar menu to: 

 

 

Create a new map –  
Under Collaboration click Create New Map 

 

View workspaces –  
Under Collaboration click My Workspaces. 

 

Start a new map from a template –  
In the sidebar menu, click Activities. 

 

This menu also give you access to your shared 

maps, Account Management functions, and Support 

resources. 

 

You can collapse or expand the menu at any time using the buttons (  or  ) at 

the top of the menu. 

While using Mindjet Catalyst mapping features, you can hide the menu to use the 

whole screen for mapping. 

 In the upper-right corner of the Workspaces or Map View window, on 

the Status Bar, click  to show or hide the menu. 
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The Workspaces window 

You can access your maps and workspaces in the Workspaces window.  

 In the Mindjet Catalyst menu, under Collaboration, click Workspaces. 

 

1. Workspaces List Shows all the workspaces where you are a member. When you select one of 
the workspaces in this list, the contents of that workspace appear in the 
Documents list. You can manage (create, rename, or delete) your workspaces 
here. 

2. Workspace 
Members List 

Displays all members of the selected workspace. Icons indicate their workspace 
access level. 

3. Documents List Shows the maps and files stored within the current workspace, current map 
users, and when they were last modified. 

4. Deleted Workspaces 
and Documents Lists 

Shows workspaces and documents in the current workspace marked for 
deletion, but not yet permanently removed (destroyed). 

5. Document Properties 
Pane 

Shows information about the selected workspace document. 

6. Status Bar   Switch between the Map View and Workspaces windows. 

 Use the Chat and Share functions. 

 Show or hide the Catalyst sidebar menu. 

 See the Mindjet Catalyst Help  and How To   videos . 
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Create a workspace and add members 

If you want to set up a workspace with documents and members of your own 

choosing, you can create a new workspace. 

 

Create a new workspace 

1. Click  at the top of the Workspaces list.  

2. Enter its name, and then click OK.  

3. The new workspace appears in the Workspaces list. 

Now you can go on to add workspace members and documents. 

 

Add workspace members 

In order for other Users of your Mindjet Catalyst account to have access to the 

documents in the workspace, you must add them as workspace members. You must 

be the Owner of the workspace to add members to it. 

1. Click  at the top of the Workspace Members list. 

2. Select from the list of account Users* and choose an Access level for the new 

members: 

 Owners have rights for access management and for adding and editing 

content A workspace can have more than one Owner. 

 Authors have rights for adding and editing content 

 Reader is lowest level, for viewing content  

3. Check Notify new members via email to send an email message to each new 

member. 

4. Click OK. 

The Workspace Members list shows the new members with icons indicating their 

Access level.  

Workspace members have access to all documents in the workspace. 

* Account Users are people that the Mindjet Catalyst account Owner has already 
invited to join the account.  

Note: you may only create workspaces if you have been granted 

workspace creation rights by your Mindjet Catalyst account Owner. 

 

 See the Mindjet Catalyst Help  for more information on 

managing workspaces. 



  

 – Quick Start Guide 13 

 

 

 Workspace Owners can manage 

members’ access to the workspace by 
clicking on the member’s Access icon. 

Remove a workspace member 

1. In the Workspaces window, select a member in the Workspace Members list. 

2. At the top of the list, click the pull-down , and then click Remove Member. 

The workspace is removed from the member's Workspaces list, and they no longer 

have access to its content.  

 

Leave a workspace 

If you are a member of a workspace but no longer need access to its contents, you 

can choose to leave it. 

 In the Workspaces list, right-click on a workspace name, and then click Leave 

Workspace. 

 

You can also right-click on a name in the Workspace Members list 

to choose a different Access level or remove the member. 
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Add documents to workspaces 

Workspaces can contain a variety of documents including maps as well as other 

types of files like Microsoft Office documents, images, and text files. You can add 

documents to workspaces by creating new maps, or by uploading existing maps and 
other files. 

 

Create a new map 

1. At the top of the Documents list, click . 

2. Enter the name for the new map, and then click OK. 

3. A new map appears in the Documents list. 

You can go on to edit the map to add content – see Edit workspace maps. 

 

Upload a document 

1. At the top of the Documents list, click . 

2. Select the document, and then click Open. 

The document is copied from your local system into the workspace on the server. The 

new workspace document is independent from the local version and is accessible by 

all workspace members.  

 

 

Note: You can only add documents to workspaces if you have 

Owner or Author access rights to the workspace. 

Hint: You can start a new map at any time from the Catalyst 

menu by clicking Create New Map. 

 You can also link to a workspace document to include it in 
another workspace, move and duplicate workspace documents. 

See the Mindjet Catalyst Help  for more information. 
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Convert a document 

You can convert workspace documents to other formats. There are three basic types 

of conversions available: 

 Convert a map to a Word or Pages file. 

 Convert a map to a PowerPoint or Keynote presentation. 

 Convert a Word or Pages file to a map. 

To convert a map or file: 

1. In the Workspaces window Documents list, right-click the map or file 
name. 

2. In the shortcut menu, click Convert to or Convert to Mind Map. 

3. Enter the name for the new document you are creating. 

No need to include a filename extension - Catalyst will add it automatically. 

4. If you are converting a map, select the format for the destination file from the 

Destination Format list. 

5. Click Convert. 

6. If you are converting a map, choose the options to use for the conversion, 
and then click Convert. 

The new document will be created in the same workspace as the original. It will be 

locked until the conversion is complete. 

 

 Documents list Columns 

When you viewing the Workspaces window, you will see the following 

columns in the Documents list: 

{document status} 

 

 

 

The document is locked or checked out for 

editing by a MindManager for Windows user. 

The document has been marked as important 

by a MindManager for Windows user. 

Document Document type and name 

Map Users Who is currently viewing or editing the map 

Modified Timestamp showing when the document was 

last changed 

You can sort the list by clicking the column headings. 

 

 See the Mindjet Catalyst Help  for complete information on 

converting and managing workspace documents. 
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Edit workspace maps 

Open a workspace map 

 In the Workspaces Window, select the map in the Documents list, and then 

click . 

 

The Map View window 

When you open a map, you see the Map View window shown on the following page. 

You can also double-click on a map name in the Documents list to open it. 

To open the last map you were working on, click Most Recent Map in the 

Catalyst sidebar menu. 
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 1. Top Toolbar Switch between Map View and the Workspaces window. 

Commands for creating, formatting and viewing maps, sharing maps, and 
chatting with other users.  

Buttons to: 

 Hide the Catalyst menu for full-screen mapping, or show it again.  

 Open or close the Task Pane. 

2. Bottom Toolbar Commands for viewing and orienting the map and finding topic text. 

3. Status Area Displays the workspace location and name of the open map, and your 
username with an activity indicator. 

It also includes these buttons: 

 About – shows the Mindjet Catalyst version and a link to the Mindjet 
Feedback form. 

 Help – shows the Mindjet Catalyst Help. 

4. Task Pane Commands and resources to speed map creation and formatting. 
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Map topics and elements 

Maps are composed of the following types of topics and elements: 

 

  
Central topic The main theme or title of your map. 

 

Main topics The major ideas that make up the theme. 

 

Subtopics Details about a topic. 

 

Callouts 

Additional information for a specific topic 
or relationship. 

 

Floating topics Auxiliary information or text. 

 

Boundaries For grouping or summarizing topics 

 

Relationships For showing connections between topics 
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You can also add textual and visual information in the form of: 

 

Topic Notes 

For more extensive, detailed 

information. 

 

Attachments To attach documents to a topic.   

  
Hyperlinks That point to other locations   

   
Markers To classify or code topics. 

 

Task 

Information 

  

For planning and tracking projects 

 

Images For visual interest 

 

Commands for adding topics and elements are found in the top toolbar and in the 
Task Pane. 

To display or hide the Task Pane:  

 Click  on the top toolbar. 

 On the top toolbar, click  Format . 

Mindjet Catalyst includes the following task panes: 

Insert task pane for adding a variety of elements to your map: relationships, 

callouts, attachments, hyperlinks, boundaries, images, notes. 

Format task pane for changing the appearance of topics and text, image 

placement and alignment within topics, and the map layout.  

Map Markers pane for applying icon and text markers for coding map topics. 

Task Info pane for assigning task information to topics. 
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Co-edit a map 

Mindjet Catalyst allows you to edit a map simultaneously with other users. This is 

called co-editing a map. Workspace Owners and Authors can edit maps that are not 
locked. (Workspace Readers can open maps as read-only documents that they can 

view, but not edit.) 

When you open a map you will see the Map Users list in the upper-right corner of 

the Map View.  This list shows who else is currently viewing or editing the 

map. Point to the list to see the names of the other users. 

Map Activity 

As other users edit the map you will see their changes in real time if you are viewing 

that portion of the map. This is referred to as Map Activity. 

Map Activity hints appear to show the current and previous actions of other users. 
Hints for current activity appear in real time, as changes are made. Hints for earlier 

activity appear when you point to a topic. 

Current Activity Earlier Activity 

 

  

 

This topic was just added  This topic was edited earlier 

Map Status 

You cannot edit a map if: 

 It is locked 

 You have only Reader access to the workspace.  

In these cases you can still open a map for viewing in Read Only mode. The Map 

Status indicator in the upper-left corner of the Map View window shows if this is the 

case. 

 

You cannot edit the map because you 
have only Reader access. 

 

You cannot edit the map because it is locked. 
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Add and edit topics 

Central topic 

When you start a new map the central topic appears with placeholder text. 

1. Click to select the central topic, and type your map’s theme or title. 

2. Press ENTER when you are finished. (Press RETURN on Mac.) 

Other topics 

You can add topics, subtopics, floating topics and callouts using the keyboard, or by 

clicking commands on the top toolbar. Select a topic, then: 

To add…  Press …  Or click toolbar command ... 

Topic  ENTER 

 

RETURN (Mac) 

 Insert>  Topic 

Subtopic  INSERT  or 
CTRL+ENTER 

CONTROL+RETURN (Mac) 

 Insert >  Subtopic 

Callout  - - - 
 Insert >  Callout 

Floating 

topic* 

 - - - 
 Insert >  Floating topic 

 
* You do not have to select a topic to add a floating topic. 

 

Enter topic text  

New topics appear with placeholder text.  

 While the topic is still selected, simply type to enter your own topic text. 

 For a multi-line topic, press SHIFT+ENTER where you want a line break. 

(Press SHIFT+RETURN on Mac.) 

 

Once you've added a topic you can go back and edit its text at any time. To make a 
topic stand out, you can format it with text and fill colors, or use a distinctive topic 

shape.  

  To add topics quickly you can right-click on a topic or on the 
map background. 

 

  See the Mindjet Catalyst Help  for a complete list of keyboard 

shortcuts. 
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Select topics 

Select a single topic or object 

 Click the topic or object. A blue highlight appears 

to show that it is selected.  

Select multiple topics and objects 

 Hold down the CTRL key (on Mac), and click to select or de-select them. 

 Hold down the SHIFT key and use the arrow keys to select additional topics. 

Select all topics within a particular area on the map 

 Click and drag a rectangle. All 

topics that the rectangle 

touches will be selected. 

 

De-select topics 

 To de-select individual topics press CTRL (on Mac) and click them. 

 To de-select all topics, click the map background. 

 

  See the Mindjet Catalyst Help  for a complete list of keyboard shortcuts. 
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Edit topics 

Replace a topic’s text 

 Select the topic and type the new text. 

Modify a topic’s text 

1. Click the topic to select it. 

2. Click again to start edit mode. The cursor 
appears in the topic text.  

3. Once you are in edit mode, you can edit the text as you do in most 

applications. 

Multi-line topics 

 For a multi-line topic, press SHIFT+ENTER where you want a line break. 

(Press SHIFT+RETURN on Mac) 

 You can also drag the topic's sizing control  , or its left or right edge to 

control the way the topic text wraps. 
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Move, copy, and delete topics 

Drag and drop topics 

You can move the topics on your map by simply clicking and dragging one or more 

topics to a new location.  

Select the topic(s) and drag them to a new 
position on the map. A red visual cue appears 

showing where the topic(s) will be added.  

 

Cut, Copy, and Paste topics 

Do one of the following: 

 Select a topic, and then click  Cut or  Copy on the toolbar. 

 Right-click a topic, and then click Copy. 

 Select a topic, and then press CTRL+C (CONTROL+C on Mac). 

Then, do one of the following: 

 Select another topic, and then click  Paste on the toolbar. 

 Right-click another topic, and then click Paste. 

 Select another topic, or click the map background, and then press CTRL+V 

(CONTROL+V on Mac). 

The cut or copied topic will be pasted as a subtopic of the selected topic. 

 

Delete topics 

To delete topics, do any of the following: 

 Select one or more topics, and then press DEL (DELETE on Mac). 

 Select one or more topics, and then click  Delete on the top toolbar. 

 Right-click a topic, and then click Delete Topic. 

 

  See the Mindjet Catalyst Help  for a complete list of keyboard 

shortcuts. 

 If you delete a topic in error you can click  Undo on the top toolbar. 
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Add information 

Notes  

Map topics are most readable when they are kept short. For topics that need more 

detail, you can add topic notes to include more information. Topic notes can be 

formatted, and can include hyperlinks to Web pages. 

Enter Notes text 

1. Select the topic. 

2. Do one of the following: 

 On the toolbar, click  Insert, and then click Notes. 

 In the Task Pane, in the Insert group, click  Notes. 

 Right-click a topic, and then click Notes. 

3. Enter the note in the Notes Pane below the map window. (You may need to 

drag the splitter up to see the window.) You can type the text or copy and 

paste it from another document. 

4. Format the note as you desire by selecting text and using the formatting 

buttons in the Notes window. 

A Notes icon appears on the topic to show that it contains a note. The Notes text 

appears in the Note Pane whenever you select the topic. 

Include a hyperlink in Notes 

1. Select some text in the Notes window. 

2. Enter the link destination in the link location box after http://.  

For example: www.mindjet.com 
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Topic Hyperlinks  

You can add a link to a topic that points to a web address, or when activated, creates 

a new email message. You can also create hyperlinks that point to another topic, 

map, workspace document, or workspace. 

1. Select a topic. 

2. Do one of the following: 

 On the toolbar, click  Insert, and then click Hyperlink. 

 In the Task Pane, in the Insert group, click  Hyperlink. 

 Right-click a topic, and then click Add Hyperlink. 

3. In the dialog, enter a link destination (a web page link with an http:// 

address or an email link with a  mailto: address) 

You'll see a link icon  appear on the topic. When you click this icon, the link is 

activated and the web page or new email message opens in a new window. 

Create a link to a topic on this map 

You can create a link to a topic on the current map using the Copy and Paste 

commands. 

1. Right-click the topic you want to link to (the target topic), and then click Copy 

as Hyperlink. 

2. Right-click the topic where you want to create the link, and then click Paste as 

Hyperlink. 

You'll see a link icon appear on the topic. When you click this icon, the link is 

activated and the target topic is selected. 

Edit a hyperlink 

1. Right-click the hyperlink icon on the topic, and then click Edit Hyperlink. 

2. Modify the link address, and then click OK. 

Remove a hyperlink 

 Right-click the hyperlink icon, and then click Delete Link. 

 

You can also create hyperlinks that point to other maps, workspace 

documents, and workspaces. See the Mindjet Catalyst Help  for more 

information. 
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Attachments   

You can attach a document to a topic, such as a Word document, a spreadsheet, a 

text file or other document type. The attached document becomes part of the map, 

independent from the original source document, and is saved with the map. You can 

add more than one attachment to a topic. 

 

Add an attachment 

1. Select a topic. 

2. Do one of the following: 

 On the toolbar, click  Insert, and then click Attachment. 

 In the Task Pane, in the Insert group, click  Attachment. 

 Right-click a topic, and then click Add Attachment. 

3. In the dialog select a document, and then click Open. 

You'll see an attachment icon appear on the topic. When you point to this icon 
you will see the list of attachments. 

View an attachment 

 

When you click the attachment icon on a topic, 
the attachment list opens. Click on the 

attachment that you want to view. It will open in 

its native application. 

In order for you to open an attachment, the attachment's document type must be 
associated with an application on your system.  

 

Remove an attachment 

1. Right-click the attachment icon on the topic and then click Delete 

Attachment. 

2. In the list of Attachments, click the attachment you want to delete from the 
topic. 

 

Note:  You can view, but not edit attachments with Mindjet Catalyst. If you edit 

the attachment while you are viewing it your changes are not saved 

back to the server. 
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Add visual cues 

Relationships   

Sometimes a relationship exists between two (or more) topics, and you want to 

illustrate this on your map. You can add a relationship line that connects two topics, 
and label it if you wish. You can change the look of the relationship using the Task 

Pane's Format settings. 

Add a relationship 

1. Do one of the following: 

 On the toolbar, click  Insert, and then click Relationship. 

 In the Task Pane, in the Insert group, click   Relationship. 

 Right-click a topic, and then click Insert Relationship. 

2. Click the first topic, and then click the second. 

The relationship line appears connecting the two topics. 

Modify and format the relationship 

 

When you select a relationship, 

handles appear so you can re-

shape it or change its connection 

point. 

Change the shape of the line 

 Select the relationship, then drag the handles .  

Connect to a different topic 

 Select the relationship then drag the connection handle  to another topic. 

Format the line's style and color 

1. Select the relationship(s). 

2. On the toolbar, click  Format. 

3. On the Task Pane, Format group, Relationship tab select the settings you 

desire. 
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Add a callout (label) to the relationship 

1. Select the relationship, and then, do one of the following: 

 On the toolbar, click  Insert, and then click Callout. 

 In the Task Pane, in the Insert group, click  Callout. 

 Right-click the relationship line, and then click Insert Callout. 

2. When the generic callout appears, enter your text. 

3. Format the callout using the Topic tab settings in the Task Pane, Format 

group. 

Remove a relationship 

Do one of the following: 

 Select the relationship, and then click  Delete on the toolbar. 

 Right-click the relationship, and then click Delete Relationship. 
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Boundaries 

Boundaries come in two basic types: grouping boundaries and summary boundaries.  

 

  

 

 
Grouping boundaries can emphasize 

the relationships between topics and 
subtopics using an outline surrounding an 

area on a map with your choice of line 

type and an optional fill color.  

   
Summary boundaries can reduce a 

set of subtopics into a single 
summary topic and then allow this 

topic to grow again. 

Create a boundary 

1. Select the topic whose subtopics you want to group with the boundary. 

2. Do one of the following: 

 On the toolbar, click  Insert, and then click Boundary. 

 In the Task Pane, in the Insert group, click   Boundary. 

You can add boundaries within boundaries. 

Format, modify, or copy a boundary 

 

When you select a boundary, blue 

highlighting appears to show that it is 
selected. Then you can change the 

boundary's formatting. 

Format a boundary 

1. Select the boundary. 

2. On the toolbar, click  Format. 

3. On the Task Pane, Format group, Boundary tab, choose the boundary 

attributes. 

 Add a summary topic (callout) to a boundary 

1. Select the boundary. 

2. Do one of the following: 

 On the toolbar, click  Insert, and then click Callout. 

 In the Task Pane, in the Insert group, click  Callout. 

 Right-click the boundary, and then click Insert Callout. 
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3. Select the generic callout and enter your own text. 

4. Format the callout using the Task Pane Format group Topic options. 

You can expand the callout into a new topic tree by adding subtopics to it. 

Remove a boundary 

 Select the boundary, and then click  Delete on the toolbar. 

 Right-click the boundary and then click Delete Boundary. 

Move or copy a boundary 

1. Select the boundary, and then click  Cut or  Copy on the toolbar. 

2. Select a topic. The boundary will enclose this topic and its subtopics. 

3. Click  Paste on the toolbar. 
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Images  

You can add images from JPG, GIF and PNG files to your map. You can add images to 

topics, subtopics, floating topics, and callouts. 

Add an image 

1. Select a topic, or create a new topic, callout, or floating topic. 

2. Do one of the following: 

 On the toolbar, click  Insert, and then click Image. 

 In the Task Pane, in the Insert group, click   Image. 

 Right-click a topic then click Add Image. 

Position the image 

The Image Placement settings allow you to orient the image relative to the topic 

text. 

1. Select the topic that contains the image. 

2. In the Task Pane, on the Format group Image tab, choose the Image 

Placement and Image Alignment settings you want to use. 

Re-size an image 

1. Select the image inside the topic. 

2. Drag the corner handles to re-size the image. 

3. To return the image to its original size, right-click the image, and then click 
Reset Image Size. 

Remove an image 

 Right-click the image inside the topic, and then click Delete Image. 
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Code topics 

Markers   

You can add two types of markers to your maps - icon markers and text markers - 

using the Task Pane Map Markers group. An icon marker is a small image that 
gives information about a topic in a graphical, easily understood way. A text marker 

is a brief notation that gives information by displaying the text below the topic. 

See the available markers 

1. Select any topic. 

2. In the Task Pane, open the Map Markers group. 

3. Use the  and  controls to expand and collapse marker groups. 

Icon markers 

Mindjet Catalyst comes with a set of icon markers that you can use for coding your 
topics. 

Apply icon markers to a topic 

1. Select one or more topics. 

2. Click on a marker in one of the Icons groups. 

You can assign icons from several different groups to a single topic, but you may 

only use one icon from each group (except Symbols).  

Copy or move icon markers 

 Drag (to copy) or CTRL+drag (to move) the icon from one topic to another. 

Change icon markers on a topic 

1. Select the topic. 

2. Do one of the following: 

 Click on a different icon in the same group as the icon you want to 

change. 

 Click the icon to cycle through other icons in that group. 

Remove icon markers from a topic 

1. Right-click the marker on the topic. 

2. Then do one of the following: 

 Click Remove to remove this single marker from the topic. 

 Click Remove All to remove all the markers from the topic. 



  

 – Quick Start Guide 34 

Text markers 

You can create your own groups of text markers to use. A group is usually a category 

or class, and the marker names within the group are its sub-categories.  

Example:  

You want to classify some topics that represent test results by their sample size. 

You create the Text marker group "Sample size" 

with markers for the categories. 

The markers display beneath the topics: 

  

 

 

Create a new text marker group 

1. In the Task Pane, open the Map Markers group. 

2. Under Text click Add Text Marker Group. 

3. Enter the Group name. 

4. Click Add. 

Add text markers to a group 

You can add text markers to a new, empty group or to an existing group. 

1. Right-click the group name, and then click New Text Marker. 

2. Enter the Name for the marker, and then click Add. 

Repeat these steps to add more markers. 

Apply text markers to a topic 

1. Select one or more topics. 

2. Click on a marker in one of the Text Markers groups. 

You can assign several text markers to a single topic, from one or more groups. 

(Markers within groups are not mutually exclusive.) 



  

 – Quick Start Guide 35 

Remove text markers from a topic 

 Right-click the marker on the topic, and then click Remove. 

 Select the topic, and then click the marker to remove in the Markers 

pane. 

Rename or remove text markers from a group 

1. In the Task Pane, right-click the marker you want to rename or remove. 

2. Click Rename Text Marker or Delete Text Marker. 

Rename or remove a text marker group 

 In the Task Pane, right-click the group name and then click Delete Text 

Marker Group. 

 In the Task Pane, right-click the group name, click Rename Text Marker 

Group, and then enter the new group name. 

Task info  

Task information is shown by marker icons (for priority and % complete), and as text 

displayed in a small window below the topic (for Resources, Duration, and Start and 
Due dates). 

Add task info to a topic 

1. Select a topic 

2. In the Task Pane, open the Task Info group. 

3. Select and enter the task info for the topic. 

 The Show Task Information and Show year in dates options apply to 

all task info on the map. 

Remove task info from a topic 

You can remove the textual task info displayed below a topic directly. (Task info icons 

can be removed in the same way as other icon markers.) 

 Right-click the Task Info text, and then click Remove. 
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Format a map 

Topic formatting 

1. Select one or more topics. 

2. On the toolbar, click Format to open the Task Pane Format group. 

3. In the Format group, select the attributes for the topic and its text on the 

Topic tab and the Text tab. 

 

Number topics 

1. Select the topic whose subtopics you want to number. 

2. In the Task Pane, on the Format Topic tab, click Numbering. 

3. Choose the numbering type. 

4. Click Depth, and choose a level.  

Numbering is dynamic - if you move or delete a numbered topic the numbering of 

the tree is automatically adjusted. 

Map layout 

Topic layout 

1. Select one or more topics. 

2. In the Task Pane, in the Format group, select options on the Layout tab. 

 Growth Direction applies to the current topic and its subtopics. 

 Line Style applies to the lines from the current topic to its subtopics. 

 Line Anchor controls the location of the connecting point of lines from 
the current topic to its subtopics. 

 You can also format a portion of the topic text by selecting it 
and then using the options on the Text tab. 
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Map background 

Change map background color 

1. Right-click an empty place on the map, and then click Background Color. 

2. Select a color, and then click OK. 

View and navigate 

Navigate, pan and zoom 

For smaller maps navigation is straightforward when the map is displayed at full size 

with all topics shown. For larger maps you may find it helpful to zoom out or change 

the level of detail to focus on a specific part of the map. 

Navigate using the keyboard 

 Use the arrow keys (left, right, up, down) to move between topics 

 Press TAB to move to the next topic. 

Panning 

To move the map use the scroll bars along the map side and bottom, or click and 

hold on the map background, and then drag it when the cursor appears. 

 Wheel mouse users can scroll using the wheel. 

To center the map, click  Center on the bottom toolbar. 

Zooming 

To adjust the Zoom factor use the slider on the bottom toolbar. 

 

 Wheel mouse users can hold CTRL and use the wheel to zoom in or out. 

To fit the map to the window, click  Fit Map on the bottom toolbar or right-click 
the map background, and then click Fit Map. 
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Level of Detail 

You can change the level of detail displayed for individual topic trees as well as for 

the entire map.  

Collapse and expand topics 

You can collapse or expand topics interactively using the icons that appear on each 

topic with subtopics. 

 Click  to expand the topic (see its subtopics) 

 Click  to collapse the topic (hide its subtopics). 

Change the Level of Detail 

1. Select a target: 

 To change the level of detail for the whole map select the central topic or 

select nothing (click the map background). 

 To change the level of detail for a topic tree, select the tree's parent topic. 

2. Choose the level of detail: 

 On the toolbar, click the  Detail pull-down to choose the level of detail. 

 Click the top part of the button to toggle between the expanded (Show All 

Levels) and collapsed (Hide All Levels) state for the map or branch. 

 Click Next Level to expand the map or topic one level at a time. 
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Focus on topic 

The Focus on Topic command shows the selected topic centered and expanded to an 

optimum level. Its sibling topics and other main topics are collapsed. 

Focus on a topic 

1. Select the topic. 

2. On the bottom toolbar, click  Focus on Topic. 

Filter 

You can use the Filter command to hide or show selected topics on your map. The 

Central Topic and the parents of displayed topics are always shown. 

1. Select one or more topics. 

2. On the top toolbar, click  Filter. 

3. Choose whether to Hide the selected topic or hide all the other topics. 

 Filtering is cumulative: to filter the map further, repeat the Filter process 

again. 

 To remove the filter, click  Filter again. 
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Find and Replace 

You can find and optionally replace text in your map topics using the Find command. 

The command searches the map in a clockwise direction, starting with the topic at 
upper-right. 

1. On the bottom status bar click  Find. 

2. Enter the text to search for, and then click . The first topic with matching 

text will be selected. 

3. Then, do any of the following: 

 To find the next matching topic (clockwise) click . 

 To find the previous matching topic click . 

 To replace the text with new text, click , then enter the new text 

in the Replace with field. Click  to change the text in the 

selected topic, or click to change all matching text in the map 
to the new text.  

 

Note: The Find command only searches through topic text, Text 

Markers, and Task Info Resources. It does not search text in topic Notes 

or in Attachments. 

The Replace command can only be used to replace topic text. 
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Print a map 

You can print the current view of a map from the Map View. It will print with topics 

expanded or collapsed, hidden or visible, just as you see on your screen.  

You can choose to print either the whole map or only the selected topic* and its 

subtopics, or, you can click and drag to select an area of the map to print. 

1. In Map View, click  File > Print Map or click File > Print Selected Topic. 

2. In the Print Preview, choose the options you want to use. 

 If you only want to print a specific area of the map, click and drag on the 
map preview to select it. 

3. Click Print. 

The map prints to your default printer. 

* If you have multiple unconnected topics selected, the Print Selected Topic 

command uses only the first topic. 

 

 You can download a copy of any workspace map to create a MindManager 

map file on your local system. See the Mindjet Catalyst Help  for more 

information. 



  

 – Quick Start Guide 42 

Share a map 

When you share a map, it is copied as a standalone, interactive Mindjet Player map 

into the My Shared Content area online. You can specify if you want to send a link to 
the published map to specific people, or post it on your favorite networking site or 

blog.  

  

Anyone who views the map can share it again using the Share command from the 

menu in the shared map. 

By default, the shared map can be copied by anyone who views it using commands 

in the map's menu: 

 Users can copy the map into a Mindjet Catalyst workspace and edit it using 
Mindjet Catalyst's browser-based mapping features, or using MindManager for 

Windows with Mindjet Catalyst (a Mindjet Catalyst account is required to copy the 

map).  

 Users can download a local copy of the map to use independently with 
MindManager for Windows (a Mindjet Catalyst account is not required to use 

downloaded maps). 

You can prevent people from making copies of your map at any time by disabling the 

copy permission after the map has been shared. 

You can select a map to share from the Workspaces window, or share the current 

map from Map View. 

1. Do one of the following: 

 From the Workspaces window: 

o In the Documents list, select a map. 

o Click  Share on the top toolbar, or in the Documents list pull-down 

menu , click Share. 

o Right-click the map name, and then click Share. 

 From Map View: 

o On the top toolbar, click  Share, or click File > Share. 

2. You will be guided through the steps to share your map by using email, 

Instant Messaging, or by publishing a link to the map on a networking site. 

3. If you want to prevent people from making copies of the shared map, disable 
the Copies Allowed setting for it on the My Shared Documents page.  

Anyone who can access this link can click it to view and interact with the shared map 
in their browser - no other software is required. The map is displayed in the Mindjet 

Player, which includes commands for further sharing the map, and (if copy 

permission is enabled) for copying or downloading the map. 

 You must be a workspace Owner or Author to share maps. 
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Manage shared maps 

 To see the content you have shared, in the Mindjet Catalyst menu under  
Collaboration, click My Shared Documents. 

On the My Shared Documents page you see the following: 

Publication Name Click the map name to preview the map in Mindjet Player  
(as others will see it) 

Publication Date  Shows when the map was first shared.  

This date does not change if you share the map again 

Copies Allowed Check this option to allow or prevent people who view the map to copy it into 
their own Mindjet Catalyst workspace or download a local copy using 
commands in the menu of the shared map. 

Share 
Click   to re-share a map that has already been shared (to post the link in a 
new place or send it to more people). 

Download Click   to download a copy of the map (in native .mmap format) to your local 
system. You can open this map with MindManager 8 for Windows or 
MindManager 8 for Mac. 

Delete Click   to remove the map from the list of shared content. The map will no 
longer be available. If you have already shared the map, when someone clicks 
on the link to see the map, they will instead see a "File not found" message. 

 You can sort your list of shared maps by clicking on the column headers. 
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View workspace files 

You can view files (non-map documents) that you have added to your workspace 

from the Workspaces window. The file will open in its native application for viewing. 

In order for you to view the file, the file's document type must be associated with an 
application on your system. 

 In the Workspaces window, Documents list do one of the following: 

 Select the file, and then click  at the top of the Documents list. 

 Double-click the file name. 

The file will open in its native application for viewing.  

 

 

Replace workspace files 

If you have Owner or Author access to a workspace, you can replace a workspace file 

with a file from your local system. This provides a means for updating or changing 
the content of any workspace file. 

 

See the Mindjet Catalyst Help  for more information on replacing files. 

 Note: You can view, but not edit files with Mindjet Catalyst. If you edit the file 

while you are viewing it, your changes are not saved back to the server. 

You can change the content of a workspace file by replacing it with a file from 

your local system. See the Mindjet Catalyst Help  for more information. 

Note: You can only replace workspace files, not workspace maps.  
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Chat  

The Chat function is similar to other instant messaging functions. You can chat with 

any member of the current workspace who is signed in.  

To begin chatting with a user, click  Chat on the Map View or Workspaces window 

top toolbar, and then choose the user you want to chat with. 

 

 

 


